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Chapter 1: Introducing the Propeller Chip 
This chapter describes the Propeller chip hardware.  To fully understand and use the Propeller 
effectively, it’s important to first understand its hardware architecture. This chapter presents 
the details of the hardware such as package types, package sizes, pin descriptions, and 
functions.   

Concept 
The Propeller chip is designed to provide high-speed processing for embedded systems while 
maintaining low current consumption and a small physical footprint.  In addition to being 
fast, the Propeller provides flexibility and power through its eight processors, called cogs, 
that can perform simultaneous independent or cooperative tasks, all while maintaining a 
relatively simple architecture that is easy to learn and utilize. 

The resulting design of the Propeller frees application developers from common complexities 
of embedded systems programming.  For example: 

• The memory map is flat.  There is no need for paging schemes with blocks of code, 
data or variables.  This is a big time-saver during application development. 

• Asynchronous events are easier to handle than they are with devices that use 
interrupts.  The Propeller has no need for interrupts; just assign some cogs to 
individual, high-bandwidth tasks and keep other cogs free and unencumbered.  The 
result is a more responsive application that is easier to maintain. 

• The Propeller Assembly language features conditional execution and optional result 
writing for each individual instruction.  This makes critical, multi-decision blocks of 
code more consistently timed; event handlers are less prone to jitter and developers 
spend less time padding, or squeezing, cycles here and there. 
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Package Types 
The Propeller chip is available in the package types shown here. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 P8X32A-Q44    

44-pin LQFP  

P8X32A-D40    40-pin DIP  

P8X32A-M44     
44-pin QFN
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Specifications 
Table 1-2: Specifications 

Model P8X32A 

Power Requirements 3.3 volts DC 

External Clock Speed DC to 80 MHz (4 MHz to 8 MHz with Clock PLL running) 

System Clock Speed DC to 80 MHz 

Internal RC Oscillator 12 MHz or 20 kHz (approximate; may range from 8 MHz – 20 MHz, 
or 13 kHz – 33 kHz, respectively) 

Main RAM/ROM 64 K bytes; 32 KB RAM + 32 KB ROM 

Cog RAM 512 x 32 bits each 

RAM/ROM Organization Long (32-bit), Word (16-bit), or Byte (8-bit) addressable 

I/O pins 32 CMOS signals with VDD/2 input threshold. 

Current Source/Sink per I/O 30 mA 

Current Source/Sink per 8 pins 100 mA 

Current Draw @ 3.3 vdc, 70 °F 500 µA per MIPS (MIPS = Freq in MHz / 4 * Number of Active Cogs) 
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Hardware Connections 
Figure 1-1 shows an example wiring diagram that provides host and EEPROM access to the 
Propeller chip.  In this example the host access is achieved through the Propeller Clip device 
(a USB to TTL serial converter). 

 

Figure 1-1: Example wiring diagram that allows for programming the Propeller chip and 
an external 32 Kbyte EEPROM, and running the Propeller with an external crystal.      
 







Introducing the Propeller Chip 

Page 20    ·    Propeller Manual v1.0 

Block Diagram 
Figure 1-2: Propeller Chip Block Diagram
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Cog and Hub interaction is critical to the Propeller chip.  The Hub controls which cog can 
access mutually-exclusive resources, such as Main RAM/ROM, configuration registers, etc. 
The Hub gives exclusive access to every cog one at a time in a “round robin” fashion, 
regardless of how many cogs are running, in order to keep timing deterministic. 
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Figure 1-3: Cog-Hub Interaction – Best Case Scenario  
 
Figure 1-4 shows the worst-case scenario; the hub instruction was ready on the cycle right 
after the start of Cog 0’s access window; it just barely missed it.  The cog waits until the next 
Hub Access Window (15 cycles later) then the hub instruction executes (7 cycles) for a total 
of 22 cycles for that hub instruction.  Again, there are 9 additional cycles after the hub 
instruction for other instructions to execute before the next Hub Access Window arrives.  To 
get the most efficiency out of Propeller Assembly routines that have to frequently access 
mutually-exclusive resources, it can be beneficial to interleave non-hub instructions with hub 
instructions to lessen the number of cycles waiting for the next Hub Access Window.  Since 
most Propeller Assembly instructions take 4 clock cycles, two such instructions can be 
executed in between otherwise contiguous hub instructions. 
 

 

Figure 1-4: Cog-Hub Interaction – Worst Case Scenario  
 
Keep in mind that a particular cog’s hub instructions do not, in any way, interfere with other 
cogs’ instructions because of the Hub mechanism.  Cog 1, for example, may start a hub 
instruction during System Clock cycle 2, in both of these examples, possibly overlapping its 
execution with that of Cog 0 without any ill effects.  Meanwhile, all other cogs can continue 
executing non-hub instructions, or awaiting their individual hub access windows regardless of 
what the others are doing. 
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I/O Pins 
The Propeller has 32 I/O pins, 28 of which are entirely general purpose.  Four I/O pins (28 - 
31) have a special purpose at Boot Up and are available for general purpose use afterwards; 
see the Boot Up Procedure section on page 18.  After boot up, any I/O pins can be used by 
any cogs at any time since I/O pins are one of the common resources.  It is up to the 
application developer to ensure that no two cogs try to use the same I/O pin for different 
purposes during run-time. 

Each cog has its own 32-bit I/O Direction Register and 32-bit I/O Output Register.  The state 
of each cog’s Direction Register is OR’d with that of the previous cogs’ Direction Registers.  
Similarly, each cog’s output states is OR’d with that of the previous cogs’ output states.  Note 
that each cog’s output states are made up of the OR’d states of its internal I/O hardware and 
that is all AND’d with its Direction Register’s states.  The result is that each I/O pin’s 
direction and output state is the “wired-OR” of the entire cog collective.  No electrical 
contention between cogs is possible, yet they can all still access the I/O pins simultaneously! 

The result of this I/O pin wiring configuration can easily be described in the following simple 
rules: 

A. A pin is an input only if no active cog sets it to an output. 

B. A pin outputs low only if all active cogs that set it to output also set it to low. 

C. A pin outputs high if any active cog sets it to an output and also sets it high. 

Table 1-4 demonstrates a few possible combinations of the collective cogs’ influence on a 
particular I/O pin, P12 in this example.  For simplification, these examples assume that bit 12 
of each cog’s I/O hardware, other than its I/O Output Register, is cleared to zero (0). 
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Table 1-4: I/O Sharing Examples 

Bit 12 of Cogs’ I/O 
Direction Register 

Bit 12 of Cogs’ I/O 
Output Register 

Cog ID 0 1 2 3 4 5 6 7 0 1 2 3 4 5 6 7 

State of I/O  Pin 
P12 

Rule 
Followed 

Example 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 Input A 

Example 2 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 Output Low B 

Example 3 1 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 Output High C 

Example 4 1 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 Output Low B 

Example 5 1 1 0 0 0 0 0 0 0 1 0 0 0 0 0 0 Output High C 

Example 6 1 1 1 1 1 1 1 1 0 1 0 1 0 0 0 0 Output High C 

Example 7 1 1 1 1 1 1 1 1 0 0 0 1 0 0 0 0 Output High C 

Example 8 1 1 1 0 1 1 1 1 0 0 0 1 0 0 0 0 Output Low B  
Note: For the I/O Direction Register, a 1 in a bit location sets the corresponding I/O pin to the 
output direction while a 0 sets it to an input direction. 

Any cog that is shut down has its Direction Register and output states cleared to zero, 
effectively removing it from influencing the final state of the I/O pins that the remaining 
active cogs are controlling.  

Each cog also has its own 32-bit Input Register.  This input register is really a pseudo-
register; every time it is read, the actual states of the I/O pins are read, regardless of their 
input or output direction.   

System Counter 
The System Counter is a global, read-only, 32-bit counter that increments once every System 
Clock cycle.  Cogs can read the System Counter (via their CNT register, page 184) to perform 
timing calculations and can use the WAITCNT command (page 322) to create effective delays 
within their processes.  The System Counter is a common resource.  Every cog can read it 
simultaneously.  The System Counter is not cleared upon startup since its practical use is for 
differential timing.  If a cog needs to keep track of time from a specific, fixed moment in 
time, it simply needs to read and save the initial counter value at that moment in time, and 
compare all of the later counter values against that initial value. 
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Table 1-7: PLLENA (Bit 6) 

Bit Effect 

0 Disables the PLL circuit.  The RCFAST and RCSLOW settings of the _CLKMODE 
declaration configure PLLENA this way. 

1 

Enables the PLL circuit. Each of the PLLxx settings of the _CLKMODE declaration 
configures PLLENA this way at compile time. The Clock PLL internally multiplies the 
XIN pin frequency by 16. OSCENA must also be ‘1’ to propagate the XIN signal to the 
Clock PLL. The Clock PLL's internal frequency must be kept within 64 MHz to 128 MHz 
– this translates to an XIN frequency range of 4 MHz to 8 MHz. Allow 100 µs for the 
Clock PLL to stabilize before switching to one of its outputs via the CLKSELx bits. 
Once the Crystal Oscillator and Clock PLL circuits are enabled and stabilized, you can 
switch freely among all clock sources by changing the CLKSELx bits.   

 

Table 1-8: OSCENA (Bit 5) 

Bit Effect 

0 Disables the Crystal Oscillator circuit.  The RCFAST and RCSLOW settings of the 
_CLKMODE declaration configure OSCENA this way. 

1 

Enables the Crystal Oscillator circuit so that a clock signal can be input to XIN, or so 
that XIN and XOUT can function together as a feedback oscillator. The XINPUT and 
XTALx settings of the _CLKMODE declaration configure OSCENA this way. The 
OSCMx bits select the operating mode of the Crystal Oscillator circuit. Note that no 
external resistors or capacitors are required for crystals and resonators. Allow a crystal 
or resonator 10 ms to stabilize before switching to a Crystal Oscillator or Clock PLL 
output via the CLKSELx bits. When enabling the Crystal Oscillator circuit, the Clock 
PLL may be enabled at the same time so that they can share the stabilization period.  

 

Table 1-9: OSCMx (Bits 4:3) 

OSCMx 

1 0 
_CLKMODE  

Setting 
XOUT  

Resistance 
XIN/XOUT 

Capacitance Frequency Range 

0 0 XINPUT Infinite 6 pF (pad only) DC to 128 MHz Input 

0 1 XTAL1 2000 Ω 36 pF 4 to 16 MHz Crystal/Resonator 

1 0 XTAL2 1000 Ω 26 pF 8 to 32 MHz Crystal/Resonator 

1 1 XTAL3 500 Ω 16 pF 20 to 60 MHz Crystal/Resonator  
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ROM.  The 32 KB of Main RAM is general purpose and is the destination of a Propeller 
Application either downloaded from a host or uploaded from the external 32 KB EEPROM.  
The 32 KB of Main ROM contains all the code and data resources vital to the Propeller chip’s 
function: character definitions, log, anti-log and sine tables, and the Boot Loader and Spin 
Interpreter.   The Main Memory organization is shown in Figure 1-5.  
 

Figure 1-5: Main 
Memory Map  

Main RAM 
The first half of Main Memory is all RAM.  This space is used for your program, data, 
variables and stack(s); otherwise known as your Propeller Application. 

When a program is loaded into the chip, either from a host or from an external EEPROM, this 
entire memory space is written. The first 16 locations, $0000 – $000F, hold initialization data 
used by the Boot Loader and Interpreter.  Your program’s executable code and data will 
begin at $0010 and extend for some number of longs. The area after your executable code, 
extending to $7FFF, is used as variable and stack space.  

There are two values stored in the initialization area that might be of interest to your program: 
a long at $0000 contains the initial master clock frequency, in Hertz, and a byte following it 
at $0004 contains the initial value written into the CLK register.  These two values can be 
read/written using their physical addresses (LONG[$0] and BYTE[$4]) and can be read by using 
their predefined names (CLKFREQ and CLKMODE).  If you change the CLK register without using 
the CLOCKSET command, you will also need to update these two locations so that objects which 
reference them will have current information. 
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Main ROM 
The second half of Main Memory is all ROM.  This space is used for character definitions, 
math functions, and the Boot Loader and Spin Interpreter. 

Character Definitions 
The first half of ROM is dedicated to a set of 256 character definitions. Each character 
definition is 16 pixels wide by 32 pixels tall. These character definitions can be used for 
video displays, graphical LCD's, printing, etc.  The character set is based on a North 
American / Western European layout (Basic Latin and Latin-1 Supplement), with many 
specialized characters inserted. The special characters are connecting waveform and 
schematic building-blocks, Greek symbols commonly used in electronics, and several arrows 
and bullets. 

 
Figure 1-6: Propeller Font Characters 

 

The character definitions are numbered 0 to 255 from left-to-right, top-to-bottom in Figure 
1-6, above.  In ROM, they are arranged with each pair of adjacent even-odd characters 
merged together to form 32 longs. The first character pair is located in bytes $8000-$807F. 
The second pair occupies bytes $8080-$80FF, and so on, until the last pair fills $BF80-
$BFFF.  The Propeller Tool includes an interactive character chart (Help → View Character 
Chart…) that has a ROM Bitmap view which shows where and how each character resides in 
ROM. 
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The character pairs are merged row-by-row such that each character's 16 horizontal pixels are 
spaced apart and interleaved with their neighbors' so that the even character takes bits 0, 2, 4, 
...30, and the odd character takes bits 1, 3, 5, ...31. The leftmost pixels are in the lowest bits, 
while the rightmost pixels are in the highest bits, as shown in Figure 1-7. This forms a long (4 
bytes) for each row of pixels in the character pair. 32 such longs, building from the 
character’s top row down to the bottom, make up the complete merged-pair definition. The 
definitions are encoded in this manner so that a cog’s video hardware can handle the merged 
longs directly, using color selection to display either the even or the odd character.  It also has 
the advantage of allowing run-time character pairs (see next paragraph) that are four-color 
characters used to draw beveled buttons, lines and focus indicators. 
 

 
Figure 1-7: Propeller Character Interleaving 

 
Some character codes have inescapable meanings, such as 9 for Tab, 10 for Line Feed, and 13 
for Carriage Return. These character codes invoke actions and do not equate to static 
character definitions. For this reason, their character definitions have been used for special 
four-color characters. These four-color characters are used for drawing 3-D box edges at run 
time and are implemented as 16 x 16 pixel cells, as opposed to the normal 16 x 32 pixel cells. 
They occupy even-odd character pairs 0-1, 8-9, 10-11, and 12-13.  Figure 1-8 shows an 
example of a button with 3D beveled edges made from some of these characters. 

 

Figure 1-8: Button 
with 3-D Beveled 
Edges 

 
The Propeller Tool includes, and uses, the Parallax True Type® font which follows the design 
of the Propeller Font embedded in the hardware.  With this font, and the Propeller Tool, you 
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promote sharing and learning from existing objects, whether they were designed by us or by 
users of the Propeller products. 

For more information about files, objects, object documentation, library files and source 
code, see Chapter 3: Propeller Programming Tutorial. 

Screen Organization 
The Propeller Tool software’s main window is split into four sections, called “panes,” each 
having a specific function. 
 

Figure 2-2: The Propeller Tool software’s main window                         
contains four major sections, or “panes.”  
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Panes one, two and three are all part of the Integrated Explorer.  The Integrated Explorer is 
the region to the left of the Editor pane (pane four) that provides views of the project you’re 
working on as well as folders and files on disk.  The Integrated Explorer is separated from the 
Editor pane by a tall, vertical splitter bar that can be resized with the mouse at any time.  The 
Integrated Explorer can even be hidden by resizing it down to nothing (left-click and drag its 
vertical splitter bar), by selecting File → Hide Explorer, or by pressing Ctrl+E.  The menu 
and shortcut options toggle the Integrated Explorer between: 1) Visible (set to its last known 
size), and 2) Invisible (completely collapsed into the left edge of the Propeller Tool. 
 

Figure 2-3: The Integrated Explorer and its components                        
can be resized via the splitter bars. 
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Pane 1: Object View Pane 
Pane one is the Object View pane.  The Propeller chip’s language, Spin, is object-based and a 
Propeller Project can be made up of multiple objects.  The Object View displays the 
hierarchical view of the project you most recently compiled successfully, providing valuable 
feedback on the relational structure of your project.  Using the Object View, you can 
determine what objects are used, how they fit together with other objects, their physical 
location on disk (work folder, library folder or editor only), redundancy optimization results 
(if any) and any potential object collision issues. See “Object View” on page 52 for more 
information. 

Pane 2: Recent Folders field and Folder List 
Pane two contains two components: 1) the Recent Folders field, and 2) the Folder List.  These 
two components work together to provide navigational access to the disk drives available to 
your computer.  The Folder List displays a hierarchical view of folders within each disk drive 
and can be manipulated in a similar fashion as the left pane of Windows® Explorer.   

The Recent Folders field (above the Folder List) provides a drop-down list of special folders 
as well as the most recent folders you’ve loaded files from.  Selecting a folder from the 
Recent Folders field causes the Folder List to immediately navigate to that folder.  In 
addition, if you select a folder in the Folder List which exists in the Recent Folders list, the 
Recent Folder field will automatically update itself to display that item.   

The first items in the Recent Folders list are “Propeller Library” and “Propeller Library – 
Demos.”  These are automatically included to point to the folders where the Propeller library 
files exist and where the demos for the library files exist.  Those files are included by the 
Propeller Tool installer. 

If you select a folder that is not in the Recent Folders list, the Recent Folder field will be 
blank.  The button to the left of the Recent Folders field toggles the function of both the 
Recent Folders and Folder List between: 1) showing every drive and folder, and 2) showing 
only drives and folders recently used.  Setting the mode to show recent folders only is a 
convenient way to quickly navigate to commonly used Propeller Project folders among a 
large set of unrelated folders on a particular drive or network. 

Pane 3: File List and Filter Field 
Pane three contains two components: 1) the File List, and 2) the Filter field.  The File List 
displays all the files contained in the folder selected from the Folder List which match the 
filter criteria of the Filter field.  The File List can be used in a similar fashion as the right 
pane of Windows Explorer.   



Using the Propeller Tool 

Page 40    ·    Propeller Manual v1.0 

The Filter field (below the File List) provides a drop-down list of file extensions, called 
filters, to display in the File List.  Typically it will be set to show Spin files only (those with 
“.spin” file extensions) but can also be set to show text files or all files.  If you navigate to a 
folder and don’t see the files you expect to see, make sure that the current filter in the Filter 
field is set appropriately.   

Files in the Files List can be opened into the editor by: 1) double-clicking them, 2) selecting 
and dragging them into the Editor pane (pane four), or 3) right-clicking them and selecting 
Open from the shortcut menu. 

Pane 4: Editor Pane 
Pane four is the Editor pane.  The Editor pane provides a view of the Spin source code files 
you’ve opened and is the area where you can review, edit, or otherwise manipulate, all the 
source code objects for your project.  Each file (source code object) you open is organized 
within the Editor pane as an individual edit tab named after the file it contains.  The currently 
active edit tab is highlighted differently than the rest.  You can have as many files open at 
once as you wish, limited only by memory.   

Clicking on an edit tab brings its edit page into view. You can switch between open files by: 
1) pressing Alt+CrsrLeft or Alt+CrsrRight, or 2) pressing Ctrl+Tab or Ctrl+Shift+Tab.  If you 
let the mouse pointer hover over an edit tab long enough it will display a hint message with 
the full path and filename of the file it represents.  The source code in the edit page is 
automatically syntax highlighted, both in foreground and background colors, to help 
distinguish block types, element types, comments vs. executable code, etc. 
 

 

Figure 2-4: Hover the mouse over an edit tab to see                           
the full path and file name that tab contains.  
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Each edit page can display source code in one of four views:  

1) Full Source  

2) Condensed  

3) Summary  

4) Documentation.   

The view mode can be seen or changed, individually for each edit tab, by: 

1) selecting the respective radio button with the mouse,  

2) pressing Alt+Up or Alt+Down,  

3) pressing Alt+<letter>, where <letter> is the underlined hot key of the desired view, or  

4) pressing Alt and moving the mouse wheel up or down.   

Note that the Documentation view can not be entered if the object can not be fully compiled 
at that moment.  See the View Modes, Bookmarks and Line Numbers section beginning on 
page 61 for more information about view modes. 

Since a project can consist of many objects, developing a project can be awkward unless you 
can see both the object you’re working on and the object you’re interfacing to at the same 
time.  The Editor pane helps here by allowing its edit tabs to be dragged and dropped to 
different locations.  For example, once multiple objects are open, you can use the left mouse 
button to select and drag the edit tab of an object down towards the bottom half of the Editor 
pane and simply drop it there.  The display changes to show you a new edit tab region where 
you just dropped that edit tab.  You can continue to drag and drop edit tabs to this new region 
if you wish.  These steps are illustrated in Figure 2-5.   
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Figure 2-5: Viewing and Arranging Multiple Objects 

 

Step 1: To see more than one object’s 
source code simultaneously, left-click 
and drag an edit tab to a lower region 
of the Editor Pane. 

 

Step 2: Release the button to drop the 
edit tab.  The edit tab and its contents 
now appear in the new region. 

 

Step 3: Repeat steps 1 and 2 as 
necessary for other edit tabs and 
resize both regions using the 
horizontal splitter between them. 

 



2: Using the Propeller Tool 

Propeller Manual v1.0   ·   Page 43        

The vertical size of these two regions can be changed by dragging the horizontal splitter bar 
separating them.  Of course, the objects you’re interfacing to can be viewed in whatever 
mode is convenient at the moment (Full Source, Condensed, Summary, or Documentation) 
while the object you’re developing remains in the Full Source view (the only editable view). 

The Editor pane even allows its edit tabs to be dragged and dropped completely outside of the 
Propeller Tool.  When this is done, the new edit tabs occupy a new window that can be 
manipulated independently of the Propeller Tool application window.  This is particularly 
useful for development on computers with more than one monitor; edit tabs can be dragged 
from the application in one monitor and dropped onto the desktop of a second monitor. 
 
Figure 2-6: Arranging Objects  

 

Step 1: If desktop space allows, you 
can even drag edit tabs outside the 
application itself; left-click and drag an 
edit tab to a region outside the 
Propeller Tool. 

 

Step 2: Release the button to drop the 
edit tab; it will drop into a form of its 
own that can be moved and sized 
independent of the Propeller Tool.  You 
can drag and drop more edit tabs into 
this new form also. 
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The Status Bar at the bottom of the Propeller Tool, is separated into six panels, each 
displaying useful information at various stages of the development process.   

Panel one of the Status Bar always displays the row and column position of the editor’s caret 
in the currently active edit tab.   
 

 

Figure 2-7: Status Bar 
 
 
Panel two displays the modified status of the current edit tab: 1) blank, meaning not modified, 
2) modified, or 3) read-only. 

Panel three shows the current edit mode: 1) Insert (default), 2) Align, or 3) Overwrite.  The 
edit mode can be changed by pressing the Insert key.  See the Edit Modes section beginning 
on page 65 for more information about how the different edit modes work. 

Panel four shows the compiled status of the current edit tab: 1) blank, meaning uncompiled, 
or 2) compiled.  This panel indicates whether or not the source code it represents is still in the 
form it was in when it was last compiled.  If the code has not been changed in any way since 
the last compile operation, this panel will say “Compiled.” 

Panel five displays context sensitive information about the current edit tab’s source code if 
that code has not been changed since the last compile operation.  Move the edit page’s caret 
to CON or DAT block symbols or anywhere within PUB/PRI blocks to see information pertaining 
to that region. 

Panel six displays temporary messages about the most recent operation.  This is the area of 
the Status Bar where the error message, if any, from the last compile operation is displayed 
until another message overwrites it.  This area also indicates successful compilations, font 
size changes and other status. 

The entire Status Bar displays hints describing the function of each menu item on the menu 
bar as well as various other items when you let the mouse pointer hover over those items. 
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Menu Items 

File Menu 
New Create a new edit tab with a blank page.  Any existing edit 

tabs are unaffected. 

Open… Open a file in a new edit tab with the Open file dialog. 

Open From… Open a file in a new edit tab from a recently accessed folder 
using the Open file dialog. 

Save Save current edit tab’s contents to disk using the existing file 
name, if applicable. 

Save As… Save current edit tab’s contents to disk with a new file name 
using the Save As dialog. 

Save To… Save current edit tab’s contents to disk in a recently accessed 
folder using the Save As dialog. 

Save All Save all unsaved edit tab’s contents to disk using their 
existing names, if applicable. 

Close Close current edit tab (will prompt if file is unsaved). 

Close All Close all edit tabs (will prompt for any files unsaved). 

Select Top Object File… Select the top object file of current project.  This setting is 
used for all of the Compile Top… operations and remains 
until changed. 

Archive  

  → Project… Collect all objects and data files for the project shown in 
Object View and store them in a compressed (.zip) file along 
with a “readme” file containing archive and structure 
information.  The compressed file is named after the 
project’s top file with “Archive” plus the date/time stamp 
appended and is stored in the top file’s work directory. 

  → Project + Propeller Tool... Perform the same task as above but add the entire Propeller 
Tool executable to the compressed file. 
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Hide/Show Explorer Hide or show the Integrated Explorer panels (left side of the 
application window). 

Print Preview… View a sample of the output before printing. 

Print… Print the current edit tab’s contents. 

<recent files> The menu area between the Print… and Exit items displays 
the most recently accessed files, up to ten.  Selecting one of 
these items opens that file.  Point the mouse at a recent file 
menu item to see the full path and file name in the status bar. 

Exit Close the Propeller Tool. 

Edit Menu 
Undo Undo the last edit action on the current edit page.  Each edit 

page retains its own undo history buffer until closed.  
Multiple undo actions are allowed, limited only by memory. 

Redo Redo the last undone action on the current edit page.  Each 
edit page retains its own redo history buffer until closed.  
Multiple redo actions are allowed, limited only by memory. 

Cut Delete the selected text from the current edit page and copy 
it to the Windows clipboard. 

Copy Copy the selected text from the current edit page to the 
Windows clipboard. 

Paste Paste text from the Windows clipboard to the current edit 
page at the current caret position. 

Select All Select all text in the current edit page. 

Find / Replace… Open the Find/Replace dialog; see Find/Replace Dialog on 
page 49 for details. 

Find Next Find the next occurrence of the last search string entered into 
the Find/Replace dialog. 

Replace Replace the current selection with the string entered into the 
Replace field of the Find/Replace dialog. 

Go To Bookmark Go to bookmark 1, 2, 3… (visible only when bookmarks are 
shown). 
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Text Bigger Increase the font size in every edit page. 

Text Smaller Decrease the font size in every edit page. 

Preferences… Open the Preferences window.  Users can customize many 
settings within the Propeller Tool using this feature. 

Run Menu 
Compile Current 

  → View Info… Compile source code in current edit tab and, if successful, 
display Object Info form with the results.  The Object Info 
form displays many details about the resulting object 
including object structure, code size, variable space, free 
space and redundancy optimizations.  

  → Update Status Compile source code in current edit tab and, if successful, 
update the status info on the Status Bar for every object in 
the project. 

  → Load RAM Compile source code in current edit tab and, if successful, 
download the resulting application into Propeller chip’s 
RAM and run it. 

  → Load EEPROM Compile source code in current edit tab and, if successful, 
download the resulting application into Propeller chip’s 
EEPROM (and RAM) and run it. 

Compile Top 

  → View Info… Same as Compile Current → View Info except compilation 
is started from the file designated as the “Top Object File.” 

  → Update Status Same as Compile Current → Update Status except 
compilation is started from the file designated as the “Top 
Object File.” 

  → Load RAM Same as Compile Current → Load RAM + Run except 
compilation is started from the file designated as the “Top 
Object File.” 

  → Load EEPROM Same as Compile Current → Load EEPROM + Run except 
the compilation is started from the file designated as the 
“Top Object File.” 
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Identify Hardware… Scan available ports for the Propeller chip and, if found, 
display the port it is connected to and the hardware version 
number. 

Help Menu 
Propeller Tool… Display on-line help about the Propeller Tool. 

Spin Language… Display on-line help about the Spin language. 

Assembly Language… Display on-line help about the Propeller Assembly language. 

Example Projects… Display on-line help containing example Propeller Projects. 

View Character Chart… Display the interactive Parallax Character Chart. This 
character chart shows the Parallax font’s character set in 
three possible views: Standard Order, ROM Bitmap and 
Symbolic Order.  Standard Order is the standard ANSI order.  
ROM Bitmap demonstrates how the character data is 
organized in the Propeller chip’s ROM.  Symbolic Order 
lists the characters in a categorical order (i.e.: alpha 
characters, numerics, punctuation, schematic symbols, etc). 
See Character Chart on page 58. 

View Parallax Website… Open up the Parallax website using the computer’s default 
web browser. 

E-mail Parallax Support… Open up the computer’s default email software and start a 
new message to Parallax support. 

About… Displays the About window with details about the Propeller 
Tool. 
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Find/Replace Dialog 
The Find/Replace dialog is used to find and/or replace text in the current edit page. 
 

 

Figure 2-8: The Find/Replace Dialog  
 

Find: 
The Find: field is where to enter the string you wish to search for.  If a word or phrase was 
selected in the current edit page when the Find/Replace dialog was opened, that word or 
phrase will automatically be entered in the Find: field.  The Find: field remembers the last ten 
unique items entered into it.  To select a previous entry, click the Find: field’s down arrow 
and choose it from the drop-down list. 

Replace: 
The Replace: field is where to enter the string you wish to replace the found string with.  The 
Replace: field remembers the last ten unique items entered into it.  To select a previous entry, 
click the Replace: field’s down arrow and choose it from the drop-down list. 

Match 
The Match group controls how the string in the Find: field is matched to text in the edit page.  
The Match options are: 1) Whole Words, 2) Case, and 3) With Wildcards. 
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Whole Words 
Select the Whole Words checkbox if you want the string in the Find: field to match only 
characters of entire words rather than both characters of entire words and characters within 
larger words. 

Case 
Select the Case checkbox if you want the string in the Find: field to match only text of the 
same case; a case-sensitive search. 

With Wildcards 
Select the With Wildcards checkbox if you want the search to be performed using regular 
expression wildcards from the string in the Find: field. 

The Origin, Scope and Direction groups all work together to dictate the start, range and 
direction the search process should use. 

Origin 
The Origin group controls where the search begins from; from the Top or from the Cursor.  
Selecting Top starts the search from the top of the file (or from the top of the selection if 
Selection is set in the Scope group).  Selecting Cursor starts the search from the current 
cursor (caret) position in the file.  Note: The “Top” option changes to “Bottom” if the 
Direction group is set to Backward. 

Scope 
The Scope group controls the range of the search: the Entire File or just the current Selection.  
This is a convenient way to perform a find, or a find and replace, within only a limited region 
of the file.  The Scope group is set to Entire File by default and is disabled unless a selection 
is made prior to opening the Find/Replace dialog.  The Scope group is set to Selection 
automatically if a selection of at least one entire line is made prior to opening the 
Find/Replace dialog. 

Direction 
The Direction group controls the direction of the search; in the Forward direction (towards 
the bottom of the file) or the Backward direction (towards the top of the file).  If set to 
Backward, the Origin group’s first option changes from “Top” to “Bottom,” meaning the 
origin is from the bottom of the file or selection. 
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Find Button 
The Find button starts the search process based on all the settings in the Find/Replace dialog.  
If text in the edit page matches the criteria, it is selected and moved into view, and then the 
Find button changes to a Find Next button.  Additional clicks on the Find Next button result 
in the next matching text being selected and shown.  You can also use the F3 key, with or 
without the Find/Replace dialog open, to perform more Find Next searches. 

Replace Button 
The Replace button is enabled if a string was entered in the Replace: field and a matching 
string was found (via Find button or F3).  Clicking Replace, or pressing F4 with or without 
the Find/Replace dialog open, causes the currently matched string in the file to be replaced 
with the string in the Replace: field.  After a replace, the Find Next button, or F3 key, needs 
to be used before Replace becomes available again.  Holding the Control (Ctrl) key down 
changes the Replace button to “Replace/Find” and clicking it, or pressing Ctrl+F4 with or 
without the Find/Replace dialog open, causes the currently matched string to be replaced and 
then another Find Next operation to be performed immediately. 

Replace All Button  
The Replace All button is enabled if a string was entered in the Replace: field.  Clicking on 
Replace All causes every matching string in the file to be found and replaced with the string 
in the Replace field, the dialog closes, and a results dialog appears indicating the number of 
occurrences found and replaced. 

Close Button 
The Close button closes the Find/Replace dialog. 
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Object View 
The Object View displays a hierarchical view of the project you most recently compiled 
successfully.  There are two Object Views in the Propeller Tool: 1) The Object View at the 
top of the Integrated Explorer in the main application’s window (see Pane 1: Object View 
Pane on page 39), and 2) The Object Info View in the upper left of the Object Info form (see 
Object Info  on page 55).  Both of these Object Views function in a similar fashion. 

The Object View provides visual feedback on the structure of the most recent successful 
compilation as well as information for each object within the compiled project.   
 

 

Figure 2-9: Example Object View display showing                             
the structure of the ABC Product compilation  

 
In Figure 2-9 above, the Object View indicates the structure of the ABC Product application.  
In this example, the ABC Product object is the “top object file” (see Objects and 
Applications, page 87) and it uses the Numbers, Rotary Encoder and Controller objects.  
Additionally, the Controller object uses the TV object. 

The object names shown are their actual file names without the extension.  The name 
includes their file extension only if they are data files (see FILE, page 215) and is shown in 
italics as well.  

The icons to the left of each object name indicate the folder that the object exists in.  This list 
shows the four possibilities:   

 (yellow): Object is within the Work Folder. 

 (blue) :  Object is within the Library Folder. 

 (striped):  Object is in Work Folder but another object with the same name is also 
being used from the Library Folder. 

 (hollow):  Object is not in any folder because it has never been saved. 
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Work Folder 
The Work Folder (yellow) is the folder where the top object file exists.  Every project has 
one, and only one, work folder. 

Library Folder 
The Library Folder (blue) is where the Propeller Tool’s library objects exist, such as those 
that came with the Propeller Tool software.  The Library Folder is always the folder that the 
Propeller Tool executable started from, and every object (file with .spin extension) within it is 
considered to be a library object. 

Striped Folders  
Objects with striped icons indicate that an object from the work folder and an object from the 
library folder each refer to a sub-object of the same name and that sub object happens to exist 
in both the work and library folders.  This same-named object may be: 1) an exact copy of the 
same object, 2) two versions of the same object, or 3) two completely different objects that 
just happen to have the same name.  Regardless of the situation, it is recommended that you 
resolve this potential problem as soon as possible since it may lead to problems later on, such 
as not being able to use the Archive feature. 

Hollow Folders 
Objects with hollow icons indicate that the object was created in the editor and has never 
been saved to any folder on the hard drive.  This situation, like the one mentioned above, is 
not an immediate problem but can lead to future problems if it is not addressed soon. 

Using the mouse to point at and select objects can provide additional information as well.  
Clicking on an object within the Object View opens that object into the Editor pane.  Left-
clicking opens that object in Full Source view, right-clicking opens it in Documentation view 
and double-clicking opens it, and all its sub-objects, in Full Source view.  If the object was 
already open, the Editor pane simply makes the related edit tab active and switches to the 
appropriate view; Full Source for a left-click or double-click, or Documentation for a right-
click. 
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Hovering the mouse over an object in the Object View displays a hint with additional 
information for that object.  Figure 2-10a shows the hint for the ABC Product object.  This 
hint indicates 1) the ABC Product object is the top object file of the project, 2) it exists in the 
work folder, and 3) its path and file name are: C:\Source\ABC Product.spin.  From this 
information you can also infer that the work folder for this project is:  

C:\Source 

 

a.  

 

b.  

Figure 2-10: Hover the mouse over an object                                 
to see hints with additional information  

 
Figure 2-10b shows the hint for the Numbers object: 1) it’s an object file (i.e.: a sub object, 
rather than the top object), 2) it’s in the library folder, and 3) it’s at the path and file name: 
C:\Program Files\Parallax Inc\Propeller\Numbers.spin.  From this information you can also 
infer that the library folder for this project is: 

C:\Program Files\Parallax Inc\Propeller. 

It’s a good idea to review the hints in the Object View occasionally since they may also 
contain additional helpful information, such as warnings about conflicts and optimization 
results. 
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Object Info  
The Object Info form displays details about the project you just compiled successfully using 
the Compile Current/Top → View Info… function.  At the top is an Info Object View very 
similar to that of the Integrated Explorer’s Object View (see Object View, p. 52).  Below the 
Info Object View are two panels with summary information.  
 

 

Figure 2-11: Object Info 
Form  
 
This example Object Info 
display shows details about 
the “ABC Product” project 
compilation. 
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Info Object View 
The Info Object View works exactly like the Object View (see Object View, p. 52) with a 
few exceptions: 

• Clicking on an object within the Info Object View updates the Object Info display 
with information pertaining to that object. 

• Double-clicking on an object within the Info Object View opens that object in the 
Edit pane. 

• Data files are not selectable in the Info Object View. 

RAM Usage Panel 
The RAM Usage panel displays statistics about RAM allocation by the object currently 
selected in the Info Object View.  The horizontal bar gives a summary view of the entire 
RAM with its color legend and numerical details below it.  For example, Figure 2-11 shows 
that the ABC Product object consumes 524 longs (2096 bytes) for program space and 12 
longs (48 bytes) for variable space, leaving over 7k longs (over 30k bytes) free.   

Clock Panel 
The clock panel, under the RAM Usage panel, displays the clock/oscillator settings of the 
object currently selected in the Info Object View.  For example, Figure 2-11 shows that the 
ABC Product object configured the clock for RCFAST, approximately 12 MHz and no XIN 
frequency. 

Hex View 
The Show/Hide Hex button shows or hides the detailed object hex view, as in Figure 2-12 on 
the next page.  The hex view shows the actual compiled object data, in hexadecimal, that are 
loaded into the Propeller chip’s RAM/EEPROM upon download. 
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Figure 2-12: Example Object Info Form display with the object Hex View           
open showing the hex values of the ABC Product compilation.  

 

The buttons under the hex display allow for downloading and saving of the currently 
displayed hex data. 

The first two buttons, Load RAM and Load EEPROM, perform the same function as the 
similarly named menu items under the Compile Current/Top menu.  It’s important to note 
that they use the current object (the one selected in the Info Object View) as the source to 
download.  In other words, you can actually select a sub-object from the project and 
download just that; a practical procedure only if that object were designed to run completely 
on its own. 

The last three buttons, Open File, Save Binary File, and Save EEPROM File, either open a 
file or save a file to disk.  The Open File button opens a previously saved Binary or EEPROM 
file into the Object Info window.  The “save” buttons save the hex data from the currently 
selected object to a file on disk.  Save Binary File saves only the portion actually used by the 
object; the program data, but not variable or stack/free space.  Save EEPROM File saves the 
entire EEPROM image, including variable and stack/free space.  Use Save EEPROM File if 
you wish to have a file that you can load into an EEPROM programmer for production 
purposes. 
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Character Chart 
The Character Chart window is available from the Help → View Character Chart… menu 
item.  It shows the entire character set for the Parallax Font that is used by the Propeller Tool 
and is also built into the ROM of the Propeller chip.  There are three views in the Character 
Chart: 1) Standard Order, 2) ROM Bitmap, and 3) Symbolic Order. 

In each of the three views, the mouse, left mouse button, cursor keys and enter button can be 
used to highlight and select a character.  If clicked (or enter pressed), the highlighted 
character will be entered into the current edit page at the current cursor location.  As a new 
character is highlighted, the title bar and info bar of the window updates to show the name, 
size and address information for that character.  Moving the mouse wheel up or down 
changes the font size displayed in this window. 

Standard Order 
Standard Order, shown in Figure 2-13, displays the characters in the order that follows that of 
the ANSI set typically used by modern day computers.   
 

 

Figure 2-13: Parallax Font Character Chart, Standard Order  
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The Vertical Resistor character (near the lower right of the display) is selected in this 
example.  The information at the bottom of the window shows the font size, in points, and the 
character’s location in the character set in decimal, hexadecimal, and Unicode.  Note: The 
Unicode value is the address of the character in the True Type® Font file that is used by the 
Propeller Tool.  The decimal and hexadecimal values are the logical addresses of the 
character in the character set within the Propeller chip and correspond to that location in the 
ANSI character set used by most computers. 

ROM Bitmap 
The ROM Bitmap, Figure 2-14, shows the characters in a way representative of how they are 
stored in the Propeller chip’s ROM.  This view uses four colors, white, light gray, dark gray, 
and black, to represent the bit pattern of each font character.  Each character, in the Propeller 
chip’s ROM, is defined with two bits of color (four colors per row in each character cell). The 
rows of each pair of adjacent characters are overlapped in memory for the purpose of creating 
the run-time characters used to draw 3D buttons with hot key and focus indicators; see 
Character Definitions on page 32.  The information at the bottom of the window shows the 
font size, in points, and the selected character’s pixel data address range in the Propeller 
chip’s ROM. 

 

Figure 2-14: Parallax Font Character Chart, ROM Bitmap  
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Symbolic Order 
Symbolic Order, Figure 2-15, shows the characters arranged categorically.  This is useful for 
finding the special characters in the Parallax font for depicting timing diagrams, lines, arrows, 
and schematics. 
 

 

Figure 2-15: Parallax Font Character Chart, Symbolic Order  
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View Modes, Bookmarks and Line Numbers 
While developing objects, or conversing about them with other users, it may sometimes be 
difficult to quickly navigate to certain regions of code simply because of the size of the file 
itself or because large sections of code and comments obscure the desired section.  There are 
a number of features built into the Propeller Tool to assist with this problem, including 
different View Modes, Bookmarks and Line Numbers. 

View Modes 
Each edit tab can display an object’s source in one of four view modes: 1) Full Source, 2) 
Condensed, 3) Summary, and 4) Documentation. 

• Full Source view displays every line of source code within the object and is the only 
view that supports editing. 

• Condensed view hides every line that contains only a code comment as well as 
contiguous lines that are blank, showing only compilable lines of code. 

• Summary view displays only the block heading lines (CON, VAR, OBJ, PUB, PRI, and 
DAT); a convenient way to see the entire object’s structure at a glance. 

• Documentation view displays the object’s documentation generated by the compiler 
from the source code’s doc comments (see Exercise 3: Output.spin - Comments on 
page 100 for more information). 

By briefly switching to another view you may be able to locate the routine or region of code 
desired.  For example, Figure 2-16a shows the Graphics object open in an edit page.  If you 
were having trouble finding the “plot” routine within the source code, you could switch to the 
Summary view (Figure 2-16b) locate the “plot” routine’s header line and click the mouse on 
that line to place the cursor there, then switch back to Full Source view (Figure 2-16c).  Keep 
your eye on the line with the cursor because the code will expand to full view above and 
below the line where the cursor is.   

The view mode can be changed a number of ways; see the Shortcut Keys listing beginning on 
page 75.  For example, while in any view mode other than Full Source, pressing the Escape 
key will take you back to Full Source view. While in Condensed or Summary view modes, 
double-clicking on a line will switch back to Full Source view; expanding above and below 
that line.  Also, the view mode bar items act like a toggle so that clicking on the Summary 
item switches back and forth between Summary view and the previous view mode. 
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Figure 2-16: View Modes Example 

a.  

b.  

c.  

 

 

 

 
Can’t find a routine in an object? 

 

 

 

 

 

Step 1: Select Summary Mode  

 

 

 

Step 2: Click on the routine’s line. 

 

 

 

 

 

Step 3: Select Full Source mode 
again; the code re-expands around 
the cursor’s line, 

-or- 

Double-click on the desired line from 
Step 2. 
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Edit Modes 
There are three edit modes provided by the Editor pane: 1) Insert (default), 2) Align 
(available for “.spin” objects only), and 3) Overwrite.  You can switch between each mode by 
using the Insert key.  The current mode is reflected by both the caret shape and by panel three 
of the status bar. 

Figure 2-19: Edit Modes 

 
 

Insert Edit Mode 

Caret is the standard blinking, vertical 
bar and the status bar shows “Insert.” 

 
 

Align Edit Mode 

Caret is a blinking underline and the 
status bar shows “Align.” 

 

Overwrite Edit Mode 

Caret is a blinking, solid block and the 
status bar shows “Overwrite.” 

 

Insert and Overwrite Modes 
The Insert and Overwrite modes are similar to that of many other text editors.  These are the 
only two modes available to edit tabs containing files other than Propeller “.spin” objects, 
such as “.txt” files. 
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Align Mode 
The Align mode is a special version of the Insert mode designed specifically for maintaining 
source code.  To understand Align mode, we first need to consider common programming 
techniques. There are two very common practices used when writing modern source code: 
indention of code and alignment of comments to the right of code.  It is also common for 
source code to be viewed and edited using more than one editor application.  Historically, 
programmers have used either tabs or spaces for indention and alignment purposes, both of 
which prove problematic.  Tab characters cause alignment issues because some editors use 
different sized tab settings than others.  Both tab and space characters cause alignment issues 
because future edits cause right-side comments to shift out of alignment.  Here are some 
examples;  Figure 2-20  is our original code. 

Figure 2-20: Common Alignment Issues – Original Code 

 
If the original code used tab characters to align the comments, changing “Delay” to 
“BtnDelay” will cause a comment to shift right if the altered text crosses a tab boundary. 

Figure 2-21: Common Alignment Issues – Tab Aligned  

 
If the original code had been made with tab characters to align the comments, 
changing “Delay” to “BtnDelay” results in the second comment suddenly being 
pushed out by another tab width. 
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If the original code used space characters to align the comments, changing “Delay” to 
“BtnDelay” will cause the comments to shift right by three characters. 
 

Figure 2-22: Common Alignment Issues – Space Aligned 

 
If the original code had been made with space characters to align the comments, 
and a standard Insert edit mode is used, changing “Delay” to “BtnDelay” results in 
the second and fifth comments being pushed out by 3 spaces. 

 
 
For Spin code, the Propeller Tool solves this problem first by disallowing tab characters (Tab 
key presses emit the proper number of space characters), and second by providing the Align 
edit mode.  While in the Align mode, characters inserted into a line affect neighboring 
characters but not characters separated by more than one space.  The result is that comments 
and other items separated by more than one space maintain their intended alignment for as 
long as possible, as shown in Figure 2-23. 
 
Figure 2-23: Effects of the Align Edit Mode  

 
Using the Align edit mode, changing “Delay” to “BtnDelay” leaves all the comments 
in their original, aligned, location.  No manual re-aligning of comments is necessary 
in this case. 
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Since the Align mode maintains existing alignments as much as possible, much less time is 
wasted realigning elements due to future edits by the programmer.  Additionally, since spaces 
are used instead of tab characters, the code maintains the same look and feel in any editor that 
displays it with a mono-spaced font. 

The Align mode isn’t perfect for all situations, however.  We recommend you use Insert 
mode for most code writing and briefly switch to Align mode to maintain existing code where 
alignment is a concern.  The Insert key rotates the mode through Insert → Align → Overwrite 
and back to Insert again.  The Ctrl+Insert key shortcut toggles only between Insert and Align 
modes. A little practice with the Align and Insert modes will help you program more time-
efficiently. 

Note that non-Spin source (without a .spin extension) does not allow the Align mode.  This is 
because, for non-Spin source, the Propeller Tool is designed to maintain any existing tab 
characters and to insert tab characters when the Tab key is pressed in order to maintain the 
original intent of the file, which may be a tab-delimited data source for a Spin program or 
other use where tab characters are desired. 

Block Selection and Selection Moving 
In addition to normal text selections made with the mouse, the Propeller Tool allows block 
selections (rectangular regions of text).  To make a block selection, first press and hold the 
Alt key, then left-click and drag the mouse to select the text region.  After the selection is 
made, cut and copy operations behave as they do with other selections.  Figure 2-24 
demonstrates block selection and movement of the text block with the mouse. 
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Figure 2-24: Block Selection and Selection Moving 

 

Original code.  We’d like to 
move the “LCD Screen Addr’’ 
comments to the right of 
the PrintMode routine. 

 

First press and hold the Alt 
key.  Next left-click and 
drag the mouse to make the 
selection. 

 

Finally, click and drag (from 
anywhere in the selected 
block) and drop the 
selection in the desired 
location. 

 

Indenting and Outdenting 
A common programming practice is to indent blocks of code that are either in loops or are 
conditionally executed in order to make that code easier to read.  The act of doing this is 
called “indenting.”  We’ll call the opposite action, shifting code to the left, “outdenting.”  The 
Spin language requires this kind of formatting to indicate which lines are within loops or 
conditional blocks.  The Propeller Tool includes the following features to make this easier to 
accomplish while creating or maintaining code. 
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Single Lines 
For Spin code, the Propeller Tool uses a set of fixed tab positions that you can change via the 
Edit → Preferences menu.  Each Spin block (CON, VAR, OBJ, PUB, PRI, and DAT) has its own 
Fixed Tab settings. 

The Tab key moves the cursor to the next tab position (to the right) and Shift + Tab moves 
the cursor to the previous tab position (to the left).  Additionally, the Backspace key moves to 
the previous tab position depending on the text around it; more on this later. 

The default tab settings for the PUB and PRI blocks include tab positions for every two 
characters near the start of the line to support common code indentions.  For example, Figure 
2-25, below, shows a public method, FSqr, containing lines at various levels of indention, 
each two characters apart. 
 

Figure 2-25: Fixed Tab 
Default Setting for 
PUB and PRI Blocks 

 
Using the Tab key, this code could have quickly been entered with the following sequence on 
the keyboard: 

• Type: “PUB FSqr” <Enter> 

• Type: <Tab> “repeat 31” <Enter> 

• Type: <Tab> “result |= root” <Enter>, etc. 

Note that the Enter key automatically aligns the cursor to the level of indention currently in 
use; this means the Tab key needs to be pressed only once to indent to the next level. 

If there are characters to the right of the cursor when the Tab key is pressed, they are shifted 
to the right as well, as in Figure 2-26. 
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Figure 2-29: Code Block Indenting 

 

Step1: Insert the 
instruction repeat 31 
above the block. 
 
 
Step 2: With a mouse, 
Select the four lines to 
indent.  

 

Step 3: Press the Tab 
key to indent the 
selected lines.  

 
 
Note that the four lines we had selected in the second step are now indented to the next fixed 
tab position (two spaces to the right of the start of the “repeat”) and the selection changed to a 
single column surrounding the first characters of the lines.  The selection changed to indicate 
that we performed a multi-line indention action.  Pressing the Tab key again will indent that 
group of lines further and pressing Shift + Tab will outdent that group of lines. 

Any contiguous group of lines can be indented or outdented in this fashion.  The selection 
itself doesn’t have to include the entire line either; it only needs to include at least one 
character of more than one line to work.  This type of selection is called a “stream” selection. 

The second type of selection, a “block” selection (see Block Selection and Selection Moving, 
page 68), can also be used to indent or outdent portions of lines.  For example, Figure 2-30 
shows our example with comments to the right of the lines. 
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Figure 2-30: Sample Code Block with Comments to the Right 

 
 
If we block select the first few characters of the comments (Alt + Left Mouse Button and 
Drag, Figure 2-31), we can press the Tab key to indent those comments to the next fixed tab 
position.  Pressing Shift + Tab will outdent them, at least up to any characters they bump into 
on their left, as in Figure 2-32.  
 
Figure 2-31: Using Block Selection to Outdent Comments 

Step 1: Block-select the comment lines (Alt + Left Mouse Button and Drag).  
 

Step 2: Press the Tab key to outdent the comments.  
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Block-Group Indicators 
Sometimes it may be hard to see exactly how groups of code are logically arranged simply by 
their level of indention.  The Propeller Tool can optionally indicate the logical block-groups 
of conditional blocks or loop blocks as shown in Figure 2-32.  To toggle this feature on or 
off, press Ctrl + I. 
 

 

Figure 2-32: Block 
Group Indicators  

 
Note that only compilable code that is actually within a conditional block or a loop block is 
actually enhanced with the indention indicators.  Also, this is simply a visual aid to see how 
the code will be executed; it does not affect the code or the source file physically; only the 
actual levels of indention do that. 
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Table 2-1: Shortcut Keys – Categorical Listing (continued) 
Compiler Shortcuts 

Function Keys 

Select Top File Ctrl + T 

Identify Hardware F7 

Compile Current File and View Information F8 

Compile Current File and Update Status F9 

Compile Current File, Load RAM and Run F10 

Compile Current File, Load EEPROM and Run F11 

Compile Top File and View Information Ctrl + F8 

Compile Top File and Update Status Ctrl + F9 

Compile Top File, Load RAM and Run Ctrl + F10 

Compile Top File, Load EEPROM and Run Ctrl + F11 

Navigation Shortcuts 

Select next edit tab Alt + Right   -or-   Ctrl + Tab 

Select previous edit tab Alt + Left   -or-  Ctrl + Shift + Tab 

Scroll up one page size Page Up 

Scroll down one page size Page Down 

Scroll left Shift + Mouse Wheel Up 

Scroll right Shift + Mouse Wheel Down 

Jump to start of next word Ctrl + Right 

Jump to start of previous word Ctrl + Left 

Jump to start of line Home 

Jump to end of line End 

Jump to start of page Ctrl + Page Up 

Jump to end of page Ctrl + Page Down 

Jump to start of file Ctrl + Home 

Jump to end of file Ctrl + End 
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Table 2-1: Shortcut Keys – Categorical Listing (continued) 
Navigation Shortcuts (cont.) 

Function Keys 

Select word Double-Click 

Select line Triple-Click 

Select to start of next word Ctrl + Shift + Right 

Select to start of previous word Ctrl + Shift + Left 

Select to start of line Shift + Home 

Select to end of line Shift + End 

Select to start of page Ctrl + Shift + Page Up 

Select to end of page Ctrl + Shift + Page Down 

Select to previous page above Shift + Page Up 

Select to next page below Shift + Page Down 

Select to start of file Ctrl + Shift + Home 

Select to end of file Ctrl + Shift + End 

Editing Shortcuts  

Undo Ctrl + Z 

Redo Ctrl + Shift + Z 

Select All Ctrl + A 

Copy to Clipboard Ctrl + C 

Cut to Clipboard Ctrl + X 

Paste from Clipboard Ctrl + V 

Find / Replace Ctrl + F 

Find Next F3 

Replace F4 

Replace then Find Next Ctrl + F4 

Change edit mode to Align, Insert or Overwrite Insert 

Toggle edit mode between Align and Insert Ctrl + Insert 

Insert white space up to next tab position Tab 

Delete white space back to previous tab position Shift + Tab 
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Table 2-1: Shortcut Keys – Categorical Listing (continued) 
Symbol Shortcuts (cont.) 

Function Keys 

Insert Multiply Character ( × ) Ctrl + Shift + * 

Insert Divide Character ( ÷ ) Ctrl + Shift + / 

Insert Radical Character ( √ ) Ctrl + Shift + R 

Insert Infinity Character ( ∞ ) Ctrl + Shift + I 

Insert Delta Character ( δ ) Ctrl + Shift + D 

Insert Mu Character ( µ ) Ctrl + Shift + M 

Insert Omega Character ( ω ) Ctrl + Shift + O 

Insert Pi Character ( π ) Ctrl + Shift + P 

Insert Sigma Character ( σ ) Ctrl + Shift + S 
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Chapter 3: Propeller Programming Tutorial 
This chapter assumes you are familiar with the general programming concepts of other 
programming languages, including object-oriented languages.  Discussion of some basic 
concepts will be presented, but some prior knowledge and programming experience is 
recommended. 

In addition to the above, this material should be read only after reading Chapters 1 and 2.  If 
you have not read through all of Chapter 1 and at least most of Chapter 2, please do so before 
continuing with this chapter.  Many items presented in Chapters 1 and 2 will be referred to 
here, but will not be described in detail. 

The following Propeller Programming Tutorial describes Propeller chip programming 
concepts in a step-by-step fashion with quick review notes along the way.  It is best to read 
this chapter from its start to its finish, without skipping around, while working with your 
computer and the Propeller chip and trying each example as it is taught.  The earlier exercises 
are basic in nature and each later exercise covers more advanced material. 

Concept 
The Propeller product (hardware, firmware and software) was designed with many well-
known and also many brand-new concepts in mind.  To this end, we designed the hardware, 
firmware, software and the two programming languages that go with it (Spin and Propeller 
Assembly) completely from scratch to give users the most direct and efficient control over 
the Propeller device. 

To fully understand and utilize these tools and languages, it is best that you approach it all 
with an open mind.  In other words, please be careful not to let legacy programming concepts 
and methods prevent you from experiencing the advantages made available by the Propeller 
chip and its programming languages.  We believe that some legacy concepts do not belong in 
true real-time processing environments since they tend to bring turmoil to those who rely on 
them. 
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Propeller Languages (Spin and Propeller Assembly) 
The Propeller chip is programmed using two languages designed specifically for it: 1) Spin, a 
high-level object-based language, and 2) Propeller Assembly, a low-level, highly-optimized 
assembly language.  There are many hardware-based commands in Propeller Assembly that 
have direct equivalents in the Spin language.  This makes learning both languages, and the 
use of the Propeller chip overall, much easier to handle.  

The Spin language is compiled by the Propeller Tool software into tokens that are interpreted 
at run time by the Propeller chip’s built-in Spin Interpreter.  Those familiar with other 
programming languages usually find that Spin is easy to learn and is well-suited for many 
applications.  With Spin you can easily perform high-level/low-bandwidth tasks and can even 
create code to handle some typically higher-bandwidth features like asynchronous serial 
communication at 19200 baud. 

The Propeller Assembly language is assembled into pure machine code by the Propeller Tool 
and is executed in its pure form at run time.  Assembly language programmers enjoy 
Propeller Assembly’s nature and its ability to achieve high-bandwidth tasks with very little 
code. 

Propeller Objects (see below) can be written entirely in Spin or can use various combinations 
of Spin and Propeller Assembly.  It’s possible to write objects almost entirely in Propeller 
Assembly as well, but at least two lines of Spin code are required to launch the final 
application. 

Propeller Objects 
The Propeller chip’s Spin language is object-based and serves as the foundation for every 
Propeller Application.   

What is an Object? 
Objects are really just programs written in a way that: 1) create a self-contained entity, 2) 
perform a specific task, and 3) may be reused by many applications.   

For example, the Keyboard object and Mouse object each come with the Propeller Tool 
software.  The Keyboard object is a program that interfaces the Propeller chip to a standard 
PC-style keyboard.  Similarly, the Mouse object interfaces to a standard computer mouse.  
Both of these objects are self-contained programs with carefully designed software interfaces 
that allow other objects, and developers, to use them easily. 
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By using existing objects, more sophisticated applications can be built very quickly.  For 
instance, an application can include both the Keyboard and Mouse objects, and with just a 
few additional lines of code, a standard user interface is realized.  Since the objects are self-
contained and provide a concise software interface, application developers don’t necessarily 
need to know exactly how an object achieves its task just to be able to use it.  In a similar 
way, a driver of a car doesn’t necessarily know how the engine works, but as long as that 
driver understands the interface (the ignition key, gas pedal, brakes, etc.) he or she can make 
the car accelerate and decelerate. 

Well-written objects can be created by one developer and easily used by many different 
applications from many different developers. 

Objects and Applications 
A Propeller Object consists of Spin code and, optionally, Propeller Assembly code; see 
Figure 3-1.  We’ll simply call these “objects” from now on. 
 

Propeller Object

Spin Code

Propeller Assembly Code

 

Figure 3-1: Propeller 
Object 

 
Objects are stored on your computer as files with “.spin” extensions, therefore you should 
always think of each Spin file as an object. 
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